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ABSTRACT 

 

The needed about improvements on education tools for better and more effective 

learning is a constant reality one time when the world evolution is a constant. This 

can be seen a portion of this in pharmacy industries and specificity drugs because 

difference in expression of the genes evolution. It throws a new area called 

pharmacogenomics, but for this is necessary very especial capable people. One 

requisite to enter in pharmacogenomics is to know about in silico tools and many 

other subjects into pharmacy course. But, in silico tools use in class looks not be a 

reality in it. To alter this, this work proposed an approximation of this reality by aux 

the teacher to introduce in silico tools into your class, primarily for Pharmacology and 

Pharmaceutical Chemistry subjects to see ligands into proteins activity site. To allow 

this, a scrip to make news complex ligand into receptor activity site by the docking 

process was established. The methodology to develop this scrip was a qualitative, 

exploratory and descriptive research to do a specification of the solution. For the 

three firstly was described the theorical concepts and the in silico tools. To the 

specification four phases was established: the theorical solution idea, the 

implementation, the usage case, and the use of molecular docking result as a 

Learning Object. The theorical solution has five modules – data source, viewer, 

editor, translator and docking. The implementation was made with Autodock Vina, 

Autodock Tools, Babel, and Discovery Studio. The usage case has as input 

molecules the Caffeine and the CYP450-3A4. Finally, the result of the docking 

process as showed and discussed in the context of education to power the learning, 

in the way to understanding the ligand and receptor interaction as Learning Object in 

context of facilitations provided by in silico tools. 

 

 

 

Key words: Molecular Docking. In Silico. AutoDock Vina. Learning Object. Learning 

And Education. 
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1 INTRODUCTION 

 

The drugs are in human life present all the time, since birth up until the moment 

before death. Prescription drug sales in the world increase every year. As presented 

in statistical analysis by a top-ranked company for pharmaceutical analysis named 

Evaluate Group. This statistical displays a $119 billion growth between 2008 up to 

2016, and a projected a growth of $286 billion between 2017 until 2022, starting from 

$774 billion in 2017 up to outlook $1,060 billion in 2022 (LERVOLINO; URQUHART, 

2017, p. 8). 

A rapidly search in US National Library of Medicine National Institutes of Health – 

NCBI – with the sentence “adverse drug events” and filter “to 1980/12/31” provides 

the count of 2960 articles, for filter “to 1990/12/31” - 5537, for filter “to 2000/12/31” - 

12435, for filter “to 2010/12/31” – 53205, and prospects for 2020 is a number 

superior to 240 thousands articles. These demonstrate that it is a very important 

research field for humanity, and so on. Many articles titles demonstrate innumerous 

diseases and genetics challenges on therapeutic drug and adverse drug events. 

Some of these adverse drug events are studied by pharmacogenetics and 

pharmacogenomics, because they derivate on variability in drug response (ROBERT, 

2004). Pharmacogenetics is a term created by Vogel of Heidelberg in 1959 (PATIL, 

2015) and according to (ROBERT, 2004) the difference with  pharmacogenomics is 

only the name, consequently a fashion to adding the suffix ‘... omics’. 

Drugs available on the market are test in a rigorous way in a big group of people. In 

this case, adverse drug events are derivate on gene unknown variations and no by 

the drug itself. Thus, on one hand, this research and clinical field generally acts on 

people that’s do not fit the general safety profile studied and guaranteed by the steps 

of launching a new drug. On other hand, in drug development phase, 

pharmacogenomics is important to predict the best configuration of a molecule. 

Drugs are thinking to patient benefit. In contrast, the same drugs that can obtain 

good results maybe do badly, depending on numerous factors. Paracelsus (1493-

1541), a renaissance physician, postulated: “What is there that is no poison? All 

things are poison and nothing is without poison. Solely the dose determines that a 

thing is not a poison” (BRUNTON; CHABNER; KNOLLMAN, 2011, p. 73). 
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In known human history, we often find reports of medicines and poisons as in the 

case of Socrates, on book “Phaedo: The Immortality of the Soul” (PLATO, 2019), 

where Socrates was subjected to drink poison because of his death sentence. The 

poison used is a cocktail of extract from Conium maculatum, also known as water 

hemlock, mixed with opium (ALI KEMAL, 2016, p. 5). 

Using plant Cicuta dry matter parts to test the potential poisoning in mice, the 

extracts of tuber and green seeds were respectively 17 mg/kg and 1320 mg/kg to 

obtain of LD50 (median lethal dose). Other a bit minors doses didn't achieve death 

but took to intoxication, much smaller doses didn't manifest toxicity effect 

(ORLANDO-GOULART et al., 2018, p. 8). Clinical signs and symptoms can be 

rhabdomyolysis, renal failure, ataxia, respiratory paralysis, headache and dermatitis, 

as were show in three cases reported, two children and one adult (ALI KEMAL, 2016, 

p. 4). 

In the above case, for all people the poison works. Other history dated 510 B.C., 

where fava beans for some people behave like poison, and for others no ill effects 

were observed in investigation performed by Pythagoras (ROBERT, 2004). 

The first case is an example of full population toxicity once was used to kill everyone 

with a death sentence. In second case, it is able to see a case to be study with 

pharmacogenomics concepts and tools. These difference between peoples that have 

toxicity, and others no, is due the first haven a deficiency of G6PD because no 

expression of this gene. This is a problem were DNA with the code of G6PD don’t 

generate RNAm to generate protein. 

More one case is related about patients of African ancestry and establish a question 

over why they don’t have a relative less response to other population ACE inhibitors 

and β-adrenergic blockers in article (BREWSTER; SEEDAT, 2013). This has 

conclusions that patients of African ancestry have therapy resistance but the 

pharmacogenomics yield heterogeneous and little data, what complicates the study.  

In the pharmacogenomics field, DNA can express RNAm and then generate protein, 

but DNA possesses a polymorphism, in the other words, a DNA has a mutation that 

changes your nucleic acids sequence. These polymorphisms can do protein to 

increase or decrease your activity. 
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Metabolisms are a way that the animal body, include human body, encounter to 

eliminate xenobiotic. Xenobiotic (drug, poison, food) is anything external to the body 

that in some way goes into to the body by enteral and parenteral administration 

routes.  

Metabolisms are divided in phase 1 - oxidation and phase 2 - conjugation. The two 

phases objective is turning the xenobiotic more hydrophilic to be more easily 

eliminated on the bile or in kidney on urine (BRUNTON; CHABNER; KNOLLMAN, 

2011, p. 123–124). The oxidation and conjugation process are driven and executed 

by enzymes. Polymorphisms in these enzymes can be cause an increase or 

decrease in these processes. 

Cytochrome P450 has the heme group, like the heme group in red blood cells 

hemoglobin. It has an iron atom that capture oxygen – O2 – in triplet state (state 

stable) and transform to oxygen singlet state (state reactive). Then, this is one step to 

xenobiotic oxidation. Next is necessary that the enzyme site of metabolism be 

compatible with xenobiotic, to xenobiotic realizing fit into enzyme and be oxidize 

(YANG et al., 2015). 

Variations on site metabolism in CYP450 can result in an augment or deduct in effect 

on drug or prodrug depends whether a polymorphisms augment or deduct the 

enzyme activity. If has polymorphisms in the metabolism enzyme then drug effect is 

deducted and prodrug effect is augment and vice versa. 

Given such characteristics provided by polymorphisms, the study of the impact in 

enzymes metabolism is important for current health mainly to pharmacists and 

physicians. 

Learn experiments can be the same way that researches do. They are three mainly 

types of experiments: in vivo, in vitro, and in silico. The two firsts depend a high cost 

and specialize laboratory. The third can be executed in a personal computer, 

accessible to more people like graduated students. 

In this way, this work is pursuing a compatible way with average computational 

hardware graduated students’ resources and free and computationally treatable 

software for experience and learning about docking drugs in a metabolite site on 

CYP450. 
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The tools that executing docking process over ligand and receptor can show results 

about these relations and thus correlation with relations founded in in vitro and in vivo 

experiments. These in silico tools to do docking process can be a good thing to aux 

educations process and in this direction this work run. 

The education need for national growth is an axiom for all nations of the world. 

Health is other, equals to education, concern problem to be more and more 

developed in a way to improve citizen’s life. Gathering the two requirements for a 

better nation life quality, the government, private initiative and universities seem a big 

challenge to train professionals for the news technologies.  

Countries like Brazil, USA, Portugal, and Spain have a good regulation in aim to 

educate new professionals to practice pharmacist activities. 

At Brazil, the MEC (Ministério da Educação e Cultura - Ministry of Education and 

Culture) jointly with CFF (Conselho Federal de Farmácia - Federal Council of 

Pharmacy), private initiative and numerous universities professors make the 

documentation that guides all universities in Brazil about the minimum curriculum. 

This is called Diretrizes Curriculares Nacionais do Curso de Graduação em Farmácia 

( Pharmacy Undergraduate National Curriculum Guidelines) (BRASILEIRO, 2017). 

Focusing attention on new drug development, in silico methods about drug 

metabolism and docking technologies, the Brazilian pharmacist curriculum legislation 

has some topics that lead these themes. Item II in Art. 5 explicit an axis in technology 

and health innovation to be worked joint pharmacist's students. The term technology 

appears fourteen times in the whole document, and also terms such as 

biopharmaceuticals, biomedicines, biotechnology, biochemistry, genetics, and 

molecular biology, obviously, appear in Portuguese. 

And more important two terms, already cited in introduction, are pharmacogenetics 

and pharmacogenomics. One time they are showed in Brazilian pharmacist 

curriculum legislation, more specific in when, among all other skills necessary to a 

pharmacist, talk about exclusively pharmacist sciences and ability to innovation 

search and development (BRASILEIRO, 2017, p. 6). 

Searching the string ‘farmacogenômica graduação Brasil’ (pharmacogenomics 

graduation Brazil) in NCBI nothing specific was found, and the string in English too. 
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The intuit is to discover if these skills ruled in Brazilian pharmacist curriculum 

legislation are fulfill for undergraduate students. 

The same string searched in Google Scholar Search Tool no return most satisfactory 

results. Only one low impact article that has one information about 

pharmacogenomics curriculum. This relate that exist a college subject called 

“Farmacocinética e Toxicocinética e Farmacogenética” (Pharmacokinetics and 

Toxicokinetics and Pharmacogenetics) in two universities only, and de subject isn’t 

just pharmacogenetics (REGINA; MORAES, 2016). This gap shows the necessity to 

improve and growth this subject in Brazil for undergraduate students. 

With the previous string we found a subchapter in a master dissertation from Portugal 

about pharmacogenomics education (BESSA, 2018, p. 15;23-24). This text explains 

that most pharmacists know about existence of pharmacogenomics, but they don’t 

know what to do and how to do. These conclusions are made with bibliography 

resources and field research with pharmacists. 

No one of these texts found give a manner and concern to discuss methods and 

materials to teacher an undergraduate about pharmacogenetics, pharmacogenomics, 

and more less, this two in context of drug docking. The article (SOUZA, 2013) among 

others preoccupations talk about the importance of these concepts in a context of 

health professional education to a personalized medicine. 

It is possible to observe that the insertion of Bioinformatics in Brazil is very rare, and 

even so, it is usually done in post-graduate courses, with only a few universities 

introducing the knowledge of Bioinformatics during graduation (RIBEIRO JUNIOR; 

OLIVEIRA; CECCATTO, 2012). 

Approach this theme go meet the news skills necessary to now undergraduate and 

future graduate pharmacist. Drug docking, not only to research, but also a way to 

develop pharmacogenomics and pharmacology ability. 

The main goal of this work is discovering applications for three-dimensional in silico 

representation of the pharmacological ligand and receptor interaction to build a script 

for preparing didactic material. 

In direction to dismember the main goal and plus more understanding about, it is 

intentions of this work to: superficially understand the existing software and to delve 

in a practical way in the chosen ones with focus and delimitation in solving the 
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problem; understand the necessary files and extensions that represent the 

molecules; establish, given the literature, the existing forms of molecular interaction 

and find out how to explain them in the chosen software; and perform a proof of 

concept of the built script. 
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2 METHODOLOGY 

 

Using the theoretical framework of (GERHARDT; SILVEIRA, 2009), the methodology 

to be used in this work is established here. The terms and their respective semantics, 

to transcribe the methodology, which are described here will be in a broader 

description in the source established above. 

Scientific knowledge depends on scientific research and carried out by scientific 

methods, above all, the acquisition of empirical knowledge can and is in many cases 

disassociated from clear and objective methods. In this way, the realization of this 

research touches both approaches, especially with the continuous and absolute care 

to only record knowledge when it is validated as scientific knowledge. 

In this work the scientific research is characterized by being: as for the approach, a 

qualitative research, because it is concerned with joining solutions of in silico 

applications to improve a subjective task, which is the preparation of didactic 

material; as for nature, it is applied research given the use of various tools that are 

already aimed at solving practical problems, thus expanding its field of action; as for 

the objectives, it is an exploratory and descriptive research when the analysis of 

tutorials and documentation of the tools and description of these are carried out to 

reach the established objectives; as for the procedures, a part, not being the most 

important, is a bibliographic search to gather concepts and other information in order 

to propose the script described in the objectives and proceed with a specification of 

solution architecture. The most important part, involving one of the cytochrome 

enzymes P450 is a drug that inhibits this enzyme, thus explaining the validity of the 

script. 

This work will be conduct with three stages that are the theorical reference, the 

collection of in silico tools and source of data, and third, by the development of the 

solution with the orchestration over the two first to do a solution. 

To the theorical reference many repositories of articles will be consulted for obtained 

the necessary information to base with conceptual framework as PubMed, NCBI - 

National Center for Biotechnology Information, Google Scholar, and so on. The focus 

of this chapter is to obtain information about the CYP450 - the receptor, ligand as 
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inhibitor on receptor and the molecular interactions, the basis for these topics, and 

about the process involved in learning. 

The collection of in silico tools and source of data will be done starting with 

information obtained from articles reads for theorical reference, by information 

derived from web forums and official tools sites. This nature of this research part is 

different because the technical information is poor described in scientific articles. 

The development will be a structuration to accomplish the goals in a way to describe 

each detail that was study in the two first steps and coordinate that into a solution. It 

is a desire to cut the development in four phases.  

The first phase is to think the architecture of solution, where it will be a conceptual 

solution that can be implemented in a variety of ways with a variety of tools. The 

second phase is one possible implementation of architecture of solution, and will has 

a defined set of tools and details about the process to use it. The third phase is 

thinking to describe a use of this implementation of architecture of solution, and some 

organization definitions to better use of it, to generate a product. Finally, this product 

will be thinking to be used into a learning and education process.  
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3 THEORICAL REFERENCE 

 

At first glance, every business wants success, and that goes for the assertion of risk 

and cost reduction when dealing with research and development, or the fact of time 

also comes into the calculation. According to the European Federation of 

Pharmaceutical Industries and Associations, a new drug available to the market has 

taken 12-13 years since its first synthesis, the cost in 2016 was close to € 1,926 

million (at the time the Euro ranged from approximately R$ 3.50 to R$ 4.5, Brazilian 

coin), and of the tested substances only one or two out of 10,000 (EFPIA, 2018). 

Therefore, means to reduce risks, costs and time are developed. Computing has 

allowed the development of so-called in silico technologies where simulations of in 

vitro and in vivo experiments can be performed. They argue (TYZACK; KIRCHMAIR, 

2019) it is important to understand the metabolism of new molecules to mitigate the 

possibility of failures in the research and development process due to ADMET 

problems (absorption, distribution, metabolism, excretion and toxicity), so it is 

important to have reliable in silico methods. 

Taking into consideration such tools, their importance for the development of new 

drugs and the objective of the present work, which is to elaborate new educational 

possibilities to explain the pharmacological ligand and receptor interaction, below 

follows a conceptual and technological arsenal describing in silico tools designed for 

research of new molecules and focusing on the understanding of metabolism 

regarding the oxidation performed by the family of enzymes called CYP450, more 

specifically CYP450-3A4 and its inhibition by some drugs. 

 

3.1 CYTOCHROME P450 

 

Cytochrome P450, which is briefly called CYP450, is a metabolizing enzyme family of 

the endogenous substances and xenobiotics, which are exogenous substances such 

as drugs. They are part of first phase metabolizing enzymes, whose main and major 

role is to oxidize substances with lipophilic characteristics, thus giving more 

hydrophilic characteristics, an important fact for the elimination of these substances 

from the body mainly through the kidneys, with drug metabolism being the focus of 
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the study of CYPs450 in pharmacology (BRUNTON; CHABNER; KNOLLMAN, 2011, 

p. 27–28, 124–125). 

Thissuper family called CYP450 or Cytochrome P450 because are a cellular prontein 

(‘cyto’), colorful (‘cromo’), and is a pigment that your light absorption is on 450nm 

wave-length (SOUZA, 2013). 

 

     Figure 1 - Scheme of the P450 nomenclature 

      Source: Adapted from(FEYEREISEN, 2012) 

 

The structure of naming the families and sub families and gene was given by 

(FEYEREISEN, 2012; NELSON et al., 1993) where by example CYP450-3A4 the 

CP450 is the family, 3 is the sub family, A4 the gene, or by example in     Figure 1. 

There are many families of CYP like: CYP1, CYP2, CYP3, CYP4, CYP5, CYP7, 

CYP21, and so on. Some are most important for xenobiotics metabolization like 

CYP2D6, CYP2C19, CYP2C9, CYP3A4 and others (BRAZ et al., 2018; GONG et al., 

2018; SOUZA, 2013; THOMFORD et al., 2016). 

This Heme group at the active site of the CYP450 acts primarily in catalyzing the 

reaction. As can be seen in    Figure 2 (YANG et al., 2015), the Fe3+ of the Heme 

group forms a complex with the RH carbon and by donating electrons from the 

NADPH via the enzyme NADPH-P450 Oxyreductase, iron is reduced to Fe2+ and an 

equilibrium reaction between the conjugate Fe2+RH and Fe2+ + RH products. 

In performing xenobiotic oxidation, the CYP450 family of enzymes performs a 

stoichiometric operation as reported in (YANG et al., 2015) where: NAD(P)H + O2 + 

R → NAD(P)+ + RO + H2O. Nicotinamide adenine dinucleotide (NAD) or 

nicotinamide adenine dinucleotide phosphate (NADP) in their reduced forms NADH 
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and NADPH participate as electron donating substrates, so the products are their 

oxidized forms NAP+ and NADP+. The portion R of the equation is the substrate 

carbon and RO is the oxidized product. 

 

    Figure 2 - CYP450 oxidative cycle 

 
     Source: Adapted from (YANG et al., 2015) 

 

The CYP450 family is considered a hemoprotein because it contains in its active site 

an invariable chemical component called heme (ferric porphyrin) which is also 

contained in hemoglobin (TYZACK; KIRCHMAIR, 2019; USSELMAN, 2017). Proteins 

that contain only amino acids are called simple, and in the case of CYP450 are called 

conjugates, the Heme being called prosthetic group (NELSON; COX, 2014, p. 89). 

The enzyme NADPH-P450 Oxyreductase is a mandatory flavoprotein for CYP450 

activity, according to (WASKELL; KIM, 2015). Its activity is by removing electrons 

from the donated NADPH to the heme acceptor of CYP450. 

In the third phase, advancing in    Figure 2, one molecular oxygen enters the reaction 

forming a conjugate Fe2+O2RH and later Fe3+-O2- RH, in which the iron is once 

again oxidized. Because it has iron in the Heme group, CYP450 is also considered a 

metalloprotein. This feature is fundamental because oxygen arrives in the triplet state 
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while organic molecules are in the singleton state, which is a ban on spin, especially 

iron metal breaks this barrier (YANG et al., 2015). 

 

3.2 CYP450-3A4 ENZYME AND YOURS INHIBITORS 

 

Given a simple mathematical relationship, given that a drug with potential toxicity and 

a low therapeutic index, and its metabolizing enzyme is inhibited, an adverse effect 

can easily occur in the drug treatment process as there will be no systemic clearing. 

Such substances that inhibit their enzyme are called inhibitors of this enzyme. 

(DERUNGS et al., 2016; USSELMAN, 2017; YANG et al., 2015). 

Going in the direction of providing statistical data on the use of CYP450-active drugs, 

the drugs were classified as inducers, inhibitors or substrates according to 

specialized literature. Totaling 94 (59.1%) of the drugs acting on CYP450 enzymes 

and 172 patients (90.5%) using any of these drugs, many with polypharmacy 

because they are all elderly. Another very important fact is that 47 (29.6%) of the 

drugs are inhibitors of CYP450-3A4 enzymes and may cause toxicity (BRAZ et al., 

2018). Both CYP450-3A4 inducers and inhibitors were tabulated, and here we adapt 

only inhibitors in Table 1. 

 

Table1 – CYP450-3A4 enzyme inhibitor drugs 

Weaks Valproic Acid, Carbamazepine, Cyclophosphamide, Clonazepam, 

Dexamethasone, Diazepam, Entacapone, Glibenclamide, Hydralazine, 

Losartan, Mirtazapine, Omeprazole, Paracetamol, Paroxetine, 

Pravastatin, Prednisone, Propranolol, Risperidone, Sildenafil, 

Theophylline, Ticlopidine, Trazodone, Venlafaxine 

Moderates Cyclosporine 

Strongs Amiodarone, Amitriptyline, Amlodipine, Atazanavir, Atorvastatin, 

Caffeine, Cimetidine, Diclofenac, Diltiazem, Efavirenz, Erythromycin, 

Fluconazole, Fluoxetine, Haloperidol, Isoniazid, Midazolam, Nifedipine, 

Norfloxacinin, Norfloxacinin, Norfloxacinin, Noravoxacinin 

    Source: Adapted from (BRAZ et al., 2018) 
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A very interesting situation was observed in the study (HO et al., 2010) which started 

from the suggestions given in some studies and tested whether garlic 

supplementation, a very common spice, in the diet was a factor inhibiting drug 

metabolism such as warfarin - anticoagulant - and saquinavir - antiretroviral, which 

are metabolized by CYP450-2C9 and CYP450-3A4. In this case it was concluded 

that garlic supplementation not only inhibited CYP450-2C9 activity but also reduced 

its expression. For CYP450-3A4 no change was detected. Although it did not affect 

CYP450-3A4, it demonstrates that foods can also generate inhibitions on cytochrome 

P450, and that it can target CYP450-3A4 enzyme. 

From the same point of view and now applied to CYP450-3A4, grain fungi in 

temperate climates can produce a class of organic compounds called Enniatins, a 

secondary metabolite. The Enniatins B1 subtype substantially reduces hydroxylation 

levels of midazolam, a benzodiazepine anxiolytic that has been specially controlled in 

clinical practice, as a substrate for CYP450-3A4 (IVANOVA et al., 2019). Also 

demonstrating interaction with midazolam as a substrate for CYP450-3A4, plant G. 

inflata has moderate inhibition (LI et al., 2017). 

 

3.3 MOLECULAR DOCKING 

 

In silico tools exist for many applications ranging from single ribbon DNA analysis, 

gene expression in RNA transcription, to mRNA translation into a protein. From 

protein in its primary structure to a tertiary or quaternary structure many in silico 

processes need to take place and validations of the three-dimensional structures to 

build a closer representation of the real. 

In counterpart addition to all of these previous steps there are in silico tools aimed at 

analyzing various aspects of the tertiary and/or quaternary structures of enzymatic 

action proteins. 

The work entitled Computational Methods And Tools To Predict Cytochrome P450 

Metabolism For Drug Discovery (TYZACK; KIRCHMAIR, 2019) brings a collection of 

many concepts and types and examples of in silico applications. It is divided into: 

methods for predicting the active site of metabolism; methods for predicting 

metabolite structure; methods for predicting the specificity of CYP450, and this is 
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very important for the present work because it deals with how a drug interaction and 

enzyme inhibition happens and the molecular docking method is responsible for 

showing the substrate binding event in the enzyme. 

Molecular docking is a way to predict how one molecule can fit in other molecule, 

normally a micro molecule to a macromolecule, by generating a variety of 

conformations over these molecules and calculate forces like Van der Walls between 

they to evaluate the best position by lowest free energy one (SCHLEINKOFER; 

WANG; WADE, 2006). To do this task, many tools exists like AutoDock, DOCK, 

FlexX, GOLD, ICM, and so on. 

To person that know about chemistry and biochemistry in a travel begin over 

Molecular Docking knowledge maybe think about a big amount of information that a 

computer should calculate and what information is necessary to do that. In general, 

Molecular Docking uses a model of reality that ignores or simplifies data to gain in 

the low-cost computer process. In alternativity, Molecular Dynamics uses a big 

quantity of data, but has a high-cost computer process.  

The (SALMASO; MORO, 2018) argue that the Molecular Dynamics is the direction to 

the future, however, for this work where we must think in low-cost computing process 

the Molecular Docking satisfies this requisite and give to us a good solution. 

 

         Figure 3 - A typical docking workflow 

 
           Source: Adapted from(SCHLEINKOFER; WANG; WADE, 2006) 
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The Molecular Docking process commonly is do with a micro molecule, the ligand, 

and a macromolecule with the active site, the target. In the         Figure 3, a typical 

Molecular Docking process is drawn with simples’ steps: select the ligand and target, 

prepper these whatever necessary, execute the docking with some in silico software 

for this, and evaluating or analysis the results.  

It is easier to realize a docking process with a drug and your protein target, in fact, 

this is a commonly use to this technique. We can think that molecules have 

flexibilities properties and movement in a variety of freedoms like translational 

androtational. In this way, the (SALMASO; MORO, 2018) classifies docking process 

by theses flexibilities and methods to calculate the process, see Figure 4. In this 

work, we won’t describe all details about this, for this, see the reference. 

 

Figure 4 - Molecular docking techniques organized according to ligand-protein 
flexibility and conformational searching engines. 

 
 Source: Adapted from(SALMASO; MORO, 2018) 
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Assuming the computation cost problem this work will focus on a semi-flexible 

docking where the ligand can be flexible and the target can’t. The ligand, for drug 

cases, is a small molecule in proportion compared to protein target. The flexibility of 

ligand augments the computation cost relatively with non-flexibility, however, this 

bring to result more details with a plausible cost. 

 

3.4 CHEMICAL STRUCTURES 

 

For understand about molecules is necessary to know about many things. One of this 

knowledge is about functional groups that would behave yourself like radical in a 

molecule, ex.: methyl, ethyl, phenyl, carbonyl (aldehyde or ketone), carboxyl, 

hydroxyl (alcohol), ether, ester, anhydride (tow carboxylic acids), amino, amido, 

guanidino, imidazole, sulfhydryl, disulfide, thioester, phosphoryl, phosphoanhydride, 

and others no cited (COX, 2013, p. 14). 

From that, many based hydrocarbon compounds should be interpreted by having one 

or more radical or functional groups. Amino acids forming a group of several based 

hydrocarbon compounds that are the basis of proteins. All amino acids have 

obligatory two functional groups and a third radical that depends on your name. In 

the same manner, deoxyribonucleic and ribonucleic acids have functional groups, 

and innumerous other molecules in a cell. 

The three-dimensional structure of give molecule is very important because one 

same molecule can be different configuration and conformation and this impact on 

interactions between biomolecules (COX, 2013, p. 16). 

 

3.5 ORGANIC CHEMISTRY INTERACTIONS 

 

In the organism, water is very important to guide many organic chemistry 

interactions. This chapter, mostly, is a resume of (COX, 2013) chapter two. Water is 

a universal solvent and it is capable to dissolve polar molecules and organize the 

nonpolar molecules in micelles. 
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Thus, water molecule breaks down your interaction with other water molecule in favor 

to do new interaction with an ion. Salts have two parts that dissolves in water, one 

anion and one cation, both interact with dipolar water. This is called ionic 

dissociation, because salts have ionic interact. 

Water interaction occurs in two fronts, one hand by oxygen with two negative 

charges and by other hand by hydrogens, that each one has a positivity charge. In 

the case of NaCl, a salt, the Na is the metal and has a positive charge that interact 

with water oxygen. For Cl, a halogen highly electronegativity, it interacts with one of 

water hydrogen. 

Not only attraction interaction that is provided by water. Repulsion is too an 

interaction supplied by water, and it is must important to life. This repulsion take 

place when water and some organic molecule interacts. This force happens because 

organic molecules are nonpolar and water are polar.  

The lipidic bilayer that forms cell membranes is an example of molecules that have 

two parts, a polar head and a nonpolar tail. Cells exist in an aqueous place and have 

water inside your body. Water act repulsing from inside and out the nonpolar part, 

and attract polar part of this molecules that form lipidic bilayer. 

Water too helps to form proteins three dimensional structures because have amino 

acids that can be a side chain polar or nonpolar. The nonpolar amino acids are 

pushed into protein body because repulsion interaction with water and polar amino 

acids are pulled out to protein surface to attraction interaction with water. When 

protein interact with water because your polar amino acids and stay in the solution 

this procedure is called solvation. 

The van der Wallsinteractions are forces that can classifies some those cited above 

or more. For (COX, 2013, p. 53), the van de Wall interactions are synonymy of 

London interaction, but for (SOLOMONS; FRYHLE, 2012, p. 76)the synonymy isn’t 

true, but the London interaction are a subpart of the it. Here, we will use this last 

concept. 

The van de Walls interactions are dipole-dipole, hydrogen bonds and dispersion 

forces. The dipole-dipole occurs when a molecule has an atom with strong 

electronegativity and pulls the electrons towards itself, therefore, it has more 
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electrons on its side, forming a high-density cloud of them. The side with this cloud is 

more negative. 

Hydrogen bonds are like a subtype of dipole-dipole that occur only when hydrogen is 

in a covalent ligation with oxygen, nitrogen or flour atom. These three atoms have a 

big electronegativity that pulls the electrons towards itself in a strong way and the 

hydrogen pushes the electrons because of your negligible electronegativity. 

Dispersion forces occur when an apolar molecule has a moment when the uniformity 

distribution of your electrons has a disturb. At this moment, some side is more 

negativity and other side is more positive. This effect impacts another neighbor 

molecule that moves your cloud of electrons, by example, whether this neighbor 

molecule stays in the positive side, then your cloud of electrons is attracted to near of 

the first.  

 

3.6 BIOCHEMISTRY INTERACTIONS AND PROPERTIES 

 

A range of interactions occurs in vivo into the body of some animal, include de 

human body. An important set of interactions happen on proteins. These proteins 

and yours correctly conformations are very important to do many vital activities. 

These conformations depend on the combination of forces derived from interactions.  

Proteins could have four levels of structures. The first level is unidimensional and is 

only a tape of amino acids. Among other properties, we shall remember that after a 

peptide ligation a reside of amino acid has two charges, a negativity with carbonyl 

and a positivity with amino group. 

Those two charges are very important to build the second level, where the protein 

can assume two major structures the alpha helix or beta sheet, and exist some 

variations of both. These structures are mainly formed by hydrogen bonds between 

oxygen derived of the carbonyl and a proton derived of the amino group.  

The proteins tertiary structures are formed when amino acid residues far from each 

other interacts. These interactions former the completely folded structure of a protein, 

and are molded by different kinds of weak bonding interactions. Other important 
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bonds are disulfide bridge, a type of covalent bond. The quaternary structures are a 

junction of tertiary like subunits of a protein. 

 

3.7 LEARNING AND EDUCATION 

 

Technology and informatic have become a reality in life today. Since more than a 

decade, this is a reality observed and this is called digital culture (CASTELLS, 2008). 

The bioinformatic is a discipline necessary to insertion in modern scientific research, 

to develop scientific community with skills and knowledge in the life science and to 

prepare the educational community to lesson for informed citizen.  More than, it has 

powerful tools to do a more solid learning for students improve yours concepts in 

curricular matters and informatic abilities (MACHLUF et al., 2017). 

It is argue in (PINTO; BOTELHO, 2012) that frontiers between work, entertainment 

and learning are decreasing, in this way, it is necessary to rethink how to teach and 

what are the tools that can be significant in learning. Thus, software that most look-

like electronic games where the ambience is more rich, interactive and stimulating 

are better. 

In a society that technology is ubiquitous, the learn is more effective whether the 

content is near to the student cognitive structure, then it is nearby to significative 

learning.  

Courses with a gamification proposal is one solution to ensure that students don’t 

give up from it. This is the case of (NEVES et al., 2016) that found in others works 

and implements a gamification process to solve the problem of evasion in courses on 

the web. Gamification has goal to motivate the student in a process more attractive to 

learn. 

The trouble with ways to visualize cells is one problem in education where students 

have difficulties with identification concepts because abstract and can’t visualize that. 

To solve this problem (AUGUSTO et al., 2016) propose diminish distance between 

theorical and practical printing a three dimensional model with a 3D printing.  

We can consider this cell printed object as an Learning Object as define in (BRAGA, 

2015). Learning Objects has a diversity of conceptualization, overall, this can be 
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understood as any object thinking and planning to auxiliary in learning something in 

education process. 

As the same way that (AUGUSTO et al., 2016) make to transform information and 

resources to a an physical object as an Learning Object is possible to transform or 

use digital resources in silico as too. 

A model of learning is stated in Figure 5 where are input and outputs (skill, will, thrill), 

three phases of the learning process (surface, deep, transfer), and success criteria 

for the task. More others details are present in that work, but for here only the input, 

output and learning process will be used instead (HATTIE; DONOGHUE, 2016). 

Surface learning process refers more to decorate facts without understand the whys 

about that fact. Deep learning process involve create your own idea fruit of your effort 

to interact with the matter and the correlation with concepts of it. Transfer learning 

process is relating to the ability to use the learned for reasoning over a context and 

apply this to another context. 

 

  Figure 5 - A model of learning 

 
       Source: Adapted from (HATTIE; DONOGHUE, 2016) 

 

The North American psychologist D. P. Ausubel formulated one theory about learning 

that is called Significative Learning. In this theory is necessarily has the desire to 

learn, or in other words motivation,previous concepts or subsumption concept, and 

the content to be learning must be potentially significant (PELIZZARI et al., 2002). 
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Continuing the argumentation, (PELIZZARI et al., 2002) say:  

The more the new content is substantially and non-arbitrarily related to some 

aspect of the previous cognitive structure that is relevant to it, the closer it is 

to meaningful learning. The less this type of relationship is established, the 

closer it is to mechanical or repetitive learning. 

Both (HATTIE; DONOGHUE, 2016) and Ausubel are correlated about the skills (as 

input) or previous concepts, the will and thrill that link with motivation. The content 

potentially significant is just one think to motivation, however, this is very important to 

be think and planning to augment the likelihood of attract and motivate the student to 

pass over all learning process. The content can be in the form of a Learning Object 

and in this work, we believe that would be fun and technological. 

In direction to fun and motivational content is necessary conceptualize the playful in 

multiple ways in a wealth of details as being an essential feature of the 

psychophysiology of human behavior, a basic need for personality, body and mind, 

thus being an experience of fullness that we fully engage. The play becomes activity 

in the action itself and in the movement experienced, requiring an internal 

predisposition to go a little further. A learning process involving playfulness is not 

supported by the traditional liturgy of expository classes because it lives with 

randomness where the individual experiences his autonomy in a different time than 

the other, generating the possibility of self-knowledge. The playful facilitates learning 

at any age and exemplifies a child with a new object to explore, so it is in playing that 

cognition develops, thus being the education style for the third millennium for many 

educators (ALMEIDA, 2009). 

With all discuss in this subchapter, the learn pass into some process, need some 

inputs, and delivery some results depending on the way that is approached. If this 

learning process is being support by a good experience and tool to facilitate the 

interaction with content, the likelihood of gain in learn is potentiated. 
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4 SOFTWARES, TYPE FILES AND DATA BANKS 

 

On course to develop our solution for solve the problem of the gap in visualization the 

theorical to factual model, some tools are select and reported bellow. 

 

4.1 AUTODOCK, AUTODOCK VINA AND AUTODOCK TOOLS 

 

According to (“AutoDock”, 2020) site, the first AutoDock version was written in Prof. 

Arthur J. Olson's Laboratory in 1989-1990 by Dr. David S. Goodsell with other name, 

AutoDoq. Thus, it was the first docking program to model the ligand with full 

conformational flexibility. After, the fourth version brought a capability to model 

flexibility both in ligand and macromolecule. 

AutoDock Vina, that is only called Vina henceforward, is a new version of AutoDock, 

in truth, Vina is other software completely different to AutoDock. Analyzing AutoDock 

and Vina to the final user usage, Vina is more easy because has less steps (VINA, 

2020). Vina has improved the accuracy and speed of docking relatively to AutoDock 

with your new score function, that is a calc to select the best ligand position and 

conformation (TROTT; OLSON, 2010). 

Auto Dock Tools, that is only called ADT from now on, is a software developed by 

Molecular Graphics Laboratory (MGL) of The Scripps Research Institute, the same 

institute that developed AutoDock and Vina (MGLTOOLS, 2020). ADT are part of 

MGLTools and is a graphical powerful tool to visualize and configuration files to be 

use in AutoDock and Vina. Beyond this, ADT is too a possible way to visualize 

results from AutoDock and Vina. 

AutoDock, AutoDock Vina and ADT has some official material to study like your own 

web site and documents like AutoDock3, AutoDock4.2.5, AutoDock4.2.6 users guide, 

AutoDock Vina Manual, and MGT Tools Documentation (“AutoDock Vina Manual”, 

2020; “Documentation — MGLTools”, 2020; FORLI et al., 2012; MORRIS et al., 

2014). 

Like some a thousand other software of innumerous purposes, theses softwares too 

have many information in a vastly communities in the internet. Some in forum, 
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personal and institutional web sites, videos, and etc. The learn in the manipulation of 

the AutoDock, AutoDock Vina and ADT to this work was made both in official 

information and nonofficial, because the nonofficial has some approaches that is not 

achieved in official. 

 

4.2 SMINA AND VINARDO 

 

Smina is a fork of Vina that has implement a way to allow different score functions 

that can be selected by user when run a docking process. This project hasn’t a nice 

website and is hosted in a count in sourceforge, where your poor documentation is 

too found (“Smina”, 2020). 

Vinardo, in its turn, is a score function that has a simplified calculation that improve 

your speed. Second (QUIROGA; VILLARREAL, 2016), “a combination of scoring, 

minimization, and re-docking on carefully curated training datasets allowed us to 

develop a simplified scoring function with optimum docking performance”. Vinardo 

outperforms Vina in all tests. 

 

4.3 DISCOVERY STUDIO 2020 CLIENT 

 

Discovery Studio 2020 Client – DSC – is a software product belonging to Biovia. This 

company has many software solutions among these products to Collaborative 

Science, Unified Lab Management, Process Production Operations, and Quality and 

Regulatory Management as they classified. Beyond this, they have provided services 

like consulting, training and support. 

Biovia has a mission to “enhance the scientific excellence and build the prestige of 

BIOVIA’s scientists, software and services by guiding the direction of company-wide 

applied science innovation, in alignment with the company strategy” (BIOVIA, 2020). 

For this work, only Discovery Studio 2020 Client was select because this tool is very 

well to use as viewer and manipulator ligand and receptor. In many cases, it found a 

crystalized protein with a ligand that can be a simple ligand, an inducer or an 

inhibitor, however we need to separated them for three reasons: more used to get 
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the protein, to get the ligand, or to get both to executing re-docking. DSC is the 

easiest tool to perform these tasks found so far by our search. 

 

4.4 PROTEIN DATA BANK AND PDB DATA FILES 

 

Protein Data Bank was the first to provide free access to digital files about 

biomacromolecules both in biology and medicine. This work began in 1971 with 

digital files arrived from nuclear magnetic resonance (NMR) methods. Today, digital 

files are provided by innumerous techniques like X-ray crystal structure 

determination, NMR, cryoelectron microscopy and theoretical modeling (BERMAN et 

al., 2002; BIOINFORMATICS, 2020). 

All file in PDB has an PDB ID that is unique for each. Some protein can be having 

many representations and conformations depending on the method to obtain its, the 

ligand that come together in your active site, and so on. These characters can be 

show in each PDB file page. 

In a PDB file page firstly us will encounter a PDB ID, some images about this protein, 

resources to visualizer and download this file, the method, resolution, citations, the 

history of version, and so on. 

 

4.5 DRUG BANK 

 

Drug Bank is more than an inventory of digital files on drugs but an encyclopedia that 

contains primally digital drugs files and more other information about these. Some 

information that we can found is:  drug indications, drug binding data as well as drug-

drug and drug-food inter-actions, the influence of hundreds of drugs on metabolite 

levels (pharmacometabolomics), gene expression levels (pharmacotranscriptomics) 

and protein expression levels (pharmacoprotoemics) (WISHART et al., 2018). 
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4.6 BABEL 

 

In addition, to manipulate digital files about proteins, drugs or other molecule we can 

found these files in a vastly types and configurations. For our need, a PDBQT file is 

necessary to be convert to PDB. PDB is a filetype that can be found at Protein Data 

Bank and Drug Bank among others and this will be primarily used here. PDBQT is a 

extended PDB filetype that is create by ADT and has some information and 

properties necessary to do the docking process. PDBQT is made from a PDB file to 

be an input file, however after docking process an output file is generate in PDBQT 

that is not accepted in DSC. For this case, it will need the Babel to do this translation. 

According to (BABEL, 2020) “Open Babel is a chemical toolbox designed to speak 

the many languages of chemical data. It's an open, collaborative project allowing 

anyone to search, convert, analyze, or store data from molecular modeling, 

chemistry, solid-state materials, biochemistry, or related areas.” 

Many information about a vastly supported filetypes, installation, details about 

conversions and filters, how to write software using the Open Babel library, and so on 

can be found in Open Babel Documentation Release 2.3.1 (HUTCHISON et al., 

2011). 
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5 DEVELOPMENT 

 

The development of this work will be giving in three times to do the theorical idea, 

implementation with your current’s limitations and usage case with CYP450-3A4. 

Theorical idea remits to think an ideal solution that not always is possible to 

implement at all. Implementation will give life to the theorical idea and those technical 

features that was not possible to implement by any reason are the limitations. The 

last is the usage case with CYP450-3A4 where the implementation will be run with 

the receptor CYP450-3A4 and one or more ligand as inhibitor. 

 

5.1 THE THEORICAL IDEA 

 

In the direction of design the theoretical idea is necessary to get together all classes 

of tools and your relationship. These tools are data source, dockers, viewers, editors, 

and translators. 

 

   Figure 6 - Solution Architecture 

 
    Source: self-elaboration 
 

These tools class and your relationship constitute the solution architecture as can 

see in    Figure 6. The center module is the Data Source where all information is 

Data Source

Dockers

Viewers

Editors

Translators
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concentrated and all others modules communicate with, in a bidirectional way, except 

viewers. From data source to other module it will be called a read process and going 

to the data source it will be called a write process. 

The Data Source is a conceptual way to relate to the files of interest. These files can 

be accessed by many ways depending on the company web site, internet protocol, 

internet URL protocol, software facilities, local files, and so on. 

Represented by arrows, the read process and write process are simple proceeding 

for computer user for many popular software solutions like a text, plan or slide editor 

because actual software for these generally hides all complexity behind the scenes. 

This facility isn’t usually a truth for biological files. 

The Viewers Module is a solution to transform the structured text from data source in 

a range of formats to show and manipulate vision in many perspectives. These 

perspectives can be linked one to other by example a three-dimensional view linked 

to amino acid letters sequence view that when select some molecule part in one view 

the selection will be show on another view. 

For this work, the more important and mandatory perspective in Viewers Module is a 

three-dimensional to show the molecule with two basics manipulate functionalities: 

zoom and rotation. Furthermore, ways to visualize the three-dimensional are 

interesting like that in the Protein Data Bank 3D View tool called Style. This Style is a 

property of any visualizer tool, where we can view molecule structure in deferent 

presentation styles like: backbone, surface, cartoon, spacefill, licorice, and line. 

The Editors Module is necessary to prepare molecules to docking. A range of 

preparations can be needed. The two most important are: cut off unwanted ligands 

from desire proteins obtained from one web Data Source and adding hydrogens 

which would be necessary for some docking tools. 

Some others features can be interesting in the Editors Module like a possibility to 

adding or removing functional groups of the drug to execute docking process with a 

drug variant and compare these results. We come to think a way adding, removing or 

alter parts of proteins to analyses the results in docking process, but this is more 

complex than a simple edition. If in the future we found in literature some indication 

that it come be a simple task with some new method or tool, it will be automatic a part 

of this solution architecture. 
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The Translator Module becomes necessary when one data file in Data Source 

Module is incompatibly with some other module that is needed for a moment. A 

variety of filetypes exist for describe molecules like: pdf files, smiles, vmol, pdbqt, and 

so on. Each filetype can be differences in data that is stored. Because of that when 

execute a translation where the destination filetype need some information that isn’t 

in the origin filetype is necessary be careful and study about this specific translation. 

The Dockers Module is the principal and more complex process in our solution 

architecture. Exists in literacy a range of algorithms to solve this problem and each of 

that use some different theory, however, discuss this algorithms and theories aren’t 

the goal here. The goal is to understand the use of the tools that will compose this 

module and how up to maximum the quality of the results when more than one result 

is given. 

The solution architecture was think to be more flexibility in your implementation and 

cover a range other approaches in education like study the files by translation 

process, protein mutation edition, concepts related to lock and key analogy or 

induced fit concept by algorithms in dockers software, however it will funnel to study 

with a focus on visualization after docking, so let's establish a procedure on solution 

architecture. The data will be given in Data Source, treated by Edition and/or 

Translation if necessary, after the Dockers module will process inputs and output the 

results, again the Translation if necessary, and at long last the Viewers. This 

procedure is not rigid on solution architecture, still it is a way to maintain 

concentration on goal. 

 

5.2 IMPLEMENTATION 

 

The implementation will cover the established procedure on solution architecture. 

Firstly, for it, the Data Source module implementation, followed by a discussion of 

some needs of Dockers module implementation that be satisfied by Editors and 

Translators implementation, the Dockers module implementation then is present and 

yours results passed by Translator module and discussed on the Viewers 

implementation. As mentioned previously, the procedure is not rigid, one example of 
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this is that Viewers will be present in many situations disorderly in relation to the 

theoretical procedure. 

The Data Source module has a folder in computer that will storage files accrue from 

Protein Data Bank and Drug Bank. Protein Data Bank is accessed by 

https://www.rcsb.org/ link and the search field provide a way to look up by PDB ID, 

author, macromolecule, sequence, or ligand. In most cases the search is by 

macromolecule name where the result show structures of it, citations that can be 

helpful for an academic work, some filters like: organism, taxonomy (eukaryote or 

bacteria), experimental method that this protein was obtained, and so on. Some 

sorting like the most important match score where it shows the quality of the 

assembly protein. 

After the choice of one structure related to the desire protein by a click on the link in 

list result, a vastly information about this protein is show like a way to view 3D 

structure and a button to download in some formats, but for this implementation of 

Data Source module only PDB filetype will be downloaded to a local folder. 

The Drug Bank is accessed by https://www.drugbank.ca/ link and the search field 

provide a way to look up firstly by name and after that a drug was found is possible to 

search by similar structures. In the similar structures screen appear some drugs with 

approximately structures and a way to drawing a new molecule to search from this. 

It is pleasing to search in the Drug Bank, in contrast with Protein Data Bank, because 

here when one drug is search one result is given. This has a logical, drugs don't have 

more than one montage, on the other hand, proteins given its complexity can be 

more than one montage. After found a desire molecule, we can view it in 2D and 3D, 

this is what we consider too Viewers implementations, simple but powerful to the 

moment. In parallel, the download can be done and in spite of has many filetypes, 

the choice is always PDB format for this work. Again, the download will be executed 

in the same folder where the protein is. 

Generally, proteins come with a ligand. In this case, it is necessary to edit the protein 

with aim to remove this ligand. This is one implementation of functionalities from 

Editors module. Thus, the Discorery Studio 2020 Client – DSC – will implement with 

an easy click selector on your implementation of Viewers module. 
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By a classic navigation to open some document in software to edit text, in DSC is the 

same File>Open and a popup window appear and is possible to navigate into folder 

that contains our desire protein. Here, it is an access to Data Source module by 

Editors and Viewers modules. Once that open the file one view will show the protein 

in 3D, where is allowed to select some molecule part with mouse click over or by hold 

press down in left mouse click and draw an area over the desire part. With hold press 

down right mouse click and move, the molecule will rotate in all three Cartesian 

planes. 

Other way to do selection is by other Viewers module implementation by a right click 

over molecule in 3D view and in popup menu click in view>hierarchy. When the file 

come with divisions over molecule is fine to use that resource at hierarchy view, 

where sometimes is more ease to select some parts of interested. 

Once one part is not interest for, it is possible to select that and delete by button ‘Del’ 

in computer keyboard. Other way is by selecting the part of interest and copy with 

classical Ctrl+c and past that in another new file, the cut with Ctrl+x also works. New 

file can be created by menu File>New>Molecule Window and after with the classical 

Ctrl+v to past into. To finish, save that by menu File>Save that will bring up a popup 

window. Write the desire name in field name, in the type field select the Protein Data 

Bank Files option, then click on button save. 

Since we have a protein and ligand molecule to do the docking process, we will open 

Auto Dock Tools – ADT – to do some others editions and now translations. ADT 

implements solutions direct or indirect for all parts of our Solution Architecture, but 

ADT is not complete or the best for all. To explain ADT in your interest, each part will 

be relating over the process to prepare for the docking process. 

Firstly, ADT implements Viewers module with a 3D and Dashboard views, where 

these are similar to 3D and hierarchy viewers respective in DSC, but the facilities to 

manipulate in DSC is better and easier for these views. 

By clicking in menu File>Read Molecule, navigate to the desire folder, select and 

open the molecule that was prepared in before steps. It will be show in a 3D and 

Dashboard views. Here, the exploration in 3D has some differences in comparison 

with DSC. To rotate the molecule, use to hold press down left mouse click and move, 
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but to selection in ADT is not possible like in DSC, it is very limited and not 

interactively. 

It is necessary to do some editions in the protein to prepper it for docking. One of this 

is remove waters and add hydrogens. Remove waters when they exist diminish the 

computer cost to realize this task. The Vina need the hydrogens that normally doesn’t 

come in protein file. To realize these jobs is very easy by click in menu Edit>Delete 

Water and Edit>Hydrogens>Add>OK. 

One time that we have prepared the protein is necessary now to translate this for the 

format required by Vina that is the PDBQT filetype. For this moment, the ADT 

implements one function of the Translators module. By click in menu 

Grid>Macromolecule>Choose a popup window with list appear to select the desire 

molecule. In this case, only one option is listed because one molecule was loaded in 

ADT then select that and click on button Select Molecule. A popup window with some 

information will appear and that can be closed, after, a window to save in PDBQT 

format is show and then save that in the same work folder. 

The same translation is necessary to drug that will be the ligand in docking process, 

but the manner to do that is a little bit different. Firstly, is necessary to open the PDB 

file that contains this drug by menu Ligand>Input>Open and chosen that is 

computers files. The molecule will be show in a 3D and Dashboard views. 

The Vina can be works with a flexibly ligand but this has a computational cost when 

more flexibly is the molecule. For this, the Vina accept a configuration to augment or 

diminish points of flexibility and this can be set by ATD by click in menu 

Ligand>Torsion Tree>Set Numbers of Torsions. A popup appear where is possible to 

choose the number of torsions and for this quantity if we want so be in points that 

impact more or less atoms. 

The flexibility can be configured to turn not-rotatable some specific ligations as: all 

peptide backbone, amide bonds, guanidinium bonds, by selected atoms, or all 

rotatable bonds. To select one or more of these options is by click in menu Ligand> 

Torsion Tree>Choose Torsions. All these configurations tools are ADT implements of 

Editors module. 
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Now, it is important to translate too the drug from PDB to PDBQT filetype. To do that 

is very simple by click in menu Ligand>Output>Save as PDBQT. After that is only 

click in Save on new popup window of course choosing the work folder. 

The next step is preparing the grid to docking process. The grid is a cartesian 

coordinates and size in Angstroms to a cube or parallelepiped that specifies a search 

space in macromolecule. This space is referent to that who we believe be an activity 

site where the drug will be to fit in. 

ADT has a way to facilitate in a visual way to delimited this space for a grid. By click 

in menu Grid>Grid Box a popup window with title Grid Options appear and a 

parallelepiped is show in 3D view that whether rotate the grid show yours face in 

blue, red and green. On Grid Options color on controls help to better identifier the 

coordinates and size, one more control is the property called Space that for Vina is 

necessary to set for one Angstrom. 

The easier and most use way to select an activity site is by use that come from 

indicated by ligand on original macromolecule. To facilitate this process is possible to 

load an original macromolecule with the ligand in 3D view in ADT. How are they the 

same one overlaps the other visually and the original ligand is show. Thus, it is 

possible to configure the grid on this visual information. 

One time that we have the receptor, the ligand, the grid coordinates and sizes is time 

to make the configure file that will be the collection of parameters to be passed to 

Vina. This configure file need, as can be seen in         Figure 7, the receptor, the 

ligand, the out to output file, the center each cartesian axis and the size for each 

cartesian axis. 

The configuration file must be saved with name conf.txt. The name is usage pattern, 

the extension is the basic text in Windows operation system, and on other like Unix 

based system the file has no extension. 

In this point all preparation for docking process is made. As mentioned before the 

Vina is the principal part of Dockers module implementation. To run Vina firstly is 

necessary to use the CMD on Windows, also know how MS-DOS, however, on Unix 

based system like Linux or Mac-OS the same functionality is called Shell or Bash, 

and for all we should call Line Command. 

 



49 
 

 

           Figure 7 - The conf.txt file 

 

             Source: self-elaboration 

 

One time on Line Command is recommended to navigate into the work folder to 

facilitate the construction of the command to call Vina with all your parameters. One 

time into work folder we can put the command Vina in Line Command and press 

enter on keyboard, this will run Vina without parameters and show to us all possible 

parameters, a specie of help or instruction manual. 

By having all in hands, now is necessary to create the command to run Vina that is 

compose by name “vina” plus “--config" parameter plus the name of file that contains 

the configuration. The final line is “vina --config conf.txt”. If you don’t want to use the 

config parameter is achievable to pass all information by specify all parameters like 

this line example “vina --receptor protein.pdbqt --ligand ligand.pdbqt --center_x -

15.01 --center_y -19.0 --center_z 10.0 --size_x 22 --size_y 22 --size_z 22 –out 

out.pdbqt”. This last way is more complex to plan and execute because is all in one 

line which leads to a greater likelihood of errors.  

One time that the command is written on Line Command is enough press enter on 

keyboard and expect the progress bar finish. When itfinishes, a small table with nine 

results sorted by scoring function will be briefly shown. The lower is affinity (kcal/mol) 

better is the result. 

receptor = protein.pdbqt 

ligand = ligand.pdbqt 

out = out.pdbqt 

center_x = -19.637 

center_y = -19.851 

center_z = -10.672 

size_x = 22 

size_y = 22 

size_z = 22 
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Navigating into work folder by way that wants is sure that a file “out.pdbqt” is there. 

This file encloses the nine molecules results that we will use with the protein to see 

the fit in activity site. However, this file is in PDBQT filetype that is not possible to be 

open in DSC then we need to convert it to PDB filetype. 

The Open Babel implements a big range of functionalities in Translators module, but 

for us the only interest is in transform PDBQT in PDB. For this execute de Open 

Babel select the input format to PDBQT and the output format to PDB. After, select 

the file to be the input and the name to the output, finish, run by button with caption 

“convert”. This process accesses the Data Source module in read and write process. 

To finish the processes, we will return to DSC to join the macromolecule with the 

results ligand positions and conformations in the same view. By click in menu 

File>Open a popup window appear to select files, navigate to work folder and select 

the file with macromolecules and the file with results then click in open. It will create 

two news tabs with each one having at first a 3D view. 

To joint these are necessary copy from results to macromolecule view and for this go 

to the view with the results. Choice a point with a considerable radius from the center 

of the molecules, press and hold left mouse button and draw a circle around the 

molecules, after, release the left mouse button. The molecules will be with gold color 

then they are selected. In the menu Edit>Copy you can copy this selection and 

navigating to another tab where macromolecule is found click in menu Edit>Paste.  

Now, to analyses one by one ligand result is necessary to turn visible the hierarchy 

view by Ctrl+h. Clicking in checklist box is possible to turn on or off visible each result 

and so on work with it. 

 

5.3 USAGE CASE WITH CYP450-3A4 AND INHIBITORS 

 

With all things considered before, now is appealing to show this in practice. Because 

of this, in this subchapter we will discuss a docking process with a structure of 

CYP450-3A4 human protein obtained by Protein Data Bank with PDB ID 4D75 and 

the caffeine, Drug Banc Accession Number - DB00201, as strong inhibitor. 
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At Protein Data Bank site, the search was executed with string “p450 3a4” and the 

choice based on the higher match score that means select the first file listed on found 

list, because this list is organized by default higher to lower in match score. The 

match score higher means that the structure has more relevance. The caffeine 

choice to inhibitor is arbitrary because your popularity in Brazil both in the form of the 

coffee drink or pure nutraceutical pill. 

On the computer is good practice create a folder called “WorkSpace”. This is a 

classical good practice in programmer life to host yours projects. Inside this folder, 

each docker project is standardized by this work with macromolecule name and PDB 

ID followed by ligand and Drug Banc Accession Number, all this information 

separated by underscore character, prohibited to use any especial character or 

accent, and all letter caps. By example for this work case, the name to folder would 

be a formation like “CYP4503A4_4D75_CAFFEINE_DB00201”. From now on, this 

folder will be cited as project folder and that is the local repository where the 

molecules will be downloaded as the way discuss in before subchapter. 

 

Figure 8 - CYP4503A4_4D75, in the left with inhibitor and the right without inhibitor 

 

   Source:self-elaboration 

 

The 4D75 molecule comes with an inhibitor together and is necessary to remove it. 

For this, use the DSC to remove it like described before how to do this process. The 

before and after about 4D75 is show in Figure 8. The part A is with original inhibitor 

comes in 4D75 and part B is without removed by DSC. The part B must be saved, we 

A B 
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use to name only the name of molecule in human body like “CYP4503A4.pdbqt” into 

project folder. 

Now is necessary to prepare the molecule to docking process adding some 

hydrogens and remove waters molecules from macromolecule, and next, translate 

both macromolecule and ligand to PDBQT filetype. For this use the ADT as was 

described before. The adding of hydrogens is very clear to see in Figure 9 by white 

balls in subpart B in contrast with subpart A. 

 
Figure 9 - CYP4503A4_4D75, A: With waters and no hydrogens; B: Without waters 

and add hydrogens 

 
  Source: self-elaboration 

 

   Figure 10 - The Grid Box configuration. 

 
   Source: self-elaboration 

 

A B 
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During the save of macromolecule in PDBQT filetype a messenger will pop up to talk 

that de Fe (iron) atom is without a charge. It is because Vina accept Fe atoms but 

can’t assign a charge to this. Many messages in official e-mail list and forums were 

consulted and many people has this problem but no one know how to solve it, at 

least, in the searches performed nothing was found. In this work, we will ignore this 

problem. 

The drug needs to be set about your flexibility and translate from PDB to PDBQT 

filetype. In the specific case no one set about flexibility of the Caffeine will be done 

because your structure is all rigid. Caffeine is a xanthine molecule with three methyls 

add to it and has an official name as 1,3,7-Trimethylxanthine. Xanthine base is rigid 

and these methyls don’t add a chance to flexibility. To finish, save the molecule as 

PDBQT as specified before with name “caffeine.pdbqt”. 

 

      Figure 11 - The conf.txt file. 

 
       Source: self-elaboration 

 

The configuration file is show in    Figure 11 where all needed information to run 

docking process in Vina is show. The information about coordinate over the Grid Box 

was perform with original macromolecule to view the ligand that comes with, as show 

in    Figure 10. Now, it run Line Command, navigate to the project folder and run 

Vina. 

receptor = CYP4503A4.pdbqt 

ligand = caffeine.pdbqt 

out = out.pdbqt 

center_x = -21.603 

center_y = -19.886 

center_z = -10.633 

size_x = 20 

size_y = 20 

size_z = 20 
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   Figure 12 - Part A: Begin of docking process; Part B: End of docking process. 

 
    Source: self-elaboration 

 

In the    Figure 12, the A part begins in navigation into the user folder to project 

folder, after executing Vina by command “vina –config conf.txt”. The B part show the 

execution with a progress bar and a table result. The next step is convert result file 

“out.pdbqt” to “out.pdb” by program Babel as show in      Figure 13. 

 

      Figure 13 - Babel convert from PDBQT to PDB 

 
       Source: self-elaboration 

 

By finish, open the DSC and into it open the “CYP4503A4.pdb” and “out.pdb” files. 

Copy from the “out.pdb” all content and past into “CYP4503A4.pdb”. The Figure 14 

show this result, but only one result is visible because was select in hierarchy view 

only “out_model_1” to not tangle the view. The caffeine is the molecule in gold color. 

A B 
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Figure 14 - Enzyme CYP450-3A4 with caffeine as inhibitor ligand show in DSC. 

 
     Source: self-elaboration 

 
By the way, this subchapter shows the usage case with CY450-3A4 and the caffeine 

as inhibitor ligand in a docking process. This is an important and complex step to 

achieved a way to analyze in 3D the ligand-receptor interaction in classroom. 

 

5.4 DISCUSSION ABOUT MOLECULAR DOCKING AND LEARNING 

 

Originally, the idea was to do a script in which the teacher would be capable to do 

more attractive material for your class. This material is a way to view molecules and 

your interactions nearer to real, to the three-dimensional immersion in contrast with 

the actual two-dimensional resources like blackboard and 2D figures in books. More 

than this, a way to allow interaction with like zoom or hide some parts, rotate the 

molecules, highlight parts or molecular interaction, show thorough atom information 

about each part, and so on. 

This work can be seen much more beyond than a script to teacher make better your 

act to teaching. However, this work can be dismembering in a range of pieces like 

Learning Objects. These possibilities are the use of those tools to innumerous 

planning tasks to growth significance of content to potentially the motivation 

sensation.  

Become with Data Source module is possible to use that by example to teacher 

about functional groups or enantiomers in Organic Chemistry subject, peptide 
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ligations or the proteins structure levels in Biochemistry subject, the drug molecules 

in Pharmacology or Pharmaceutical Chemistry subject, DNA and RNA details in 

Genetic subject. In three first cases are possible to think a Learning Object with the 

Protein Data Bank or Drug Bank as a source of information and too as an easier, 

free, simply and low computer cost Viewers module implementation to see the three-

dimensional of molecules. To DNA and RNA exist other platforms tolls and 

techniques, not cited in this work, however this can be related with the proteins in the 

level of in silico data. 

It is feasible to argument about many others uses over these in silico tools like a 

Learning Object. Above all, more important to this work is discuss the result of 

docking process with the needs of visualizer details about the interaction 

macromolecule with ligand in activity site. 

A new Learning Object is defined here with some resources, desired previous 

concepts that the student should have to possess to interact with it, and the expected 

learned concepts that the student should know after the free time of interaction. 

The desired previous concepts will be the first to describe here because a logical 

reasoner. The student needs to know, at left and reasonably, the information present 

in the subchapters 3.4 up until 3.6. These is important to be capable to think about 

interactions of molecules. Others interesting knowledge are about Pharmaceutical 

Chemistry and Pharmacology. 

The resources are a docked result, the macromolecule and the visualizer. The tools 

of visualizer have to show the interactions like hydrogens bonds, Van Der Waals 

forces, and so on, and show molecules in a variety of ways, highlight parts like the 

atoms of lateral chain of an amino acid, contrast the limits of macromolecule with the 

ligand, and so on. The more resources that the visualization tool has is cool to the 

exploration and student can be learn it by yourself curiosity, however is much 

important that the teacher instruct the student about those minimum necessary. 

This minimum necessary is just like in Figure 15, where has some colors margins 

edging areas of interesting to discuss. Into yellow margin in gold color a caffeine 

molecule as ligand near to the heme prosthetic group with some dashed lines from 

caffeine parts to macromolecule parts indicating the interactions. 
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The red margin shows the hierarchy of the data that is showing in visual three-

dimensional molecule. There has too here the description of ligations showed into 

yellow margin. These ligations are sub items of “Non-bond Monitor 1” where is 

possible to see the amino acids and yours numbers involved in.  

The orange margin another way to show data from molecules. Many tabs are there to 

aux in search the specified information. In the tab “AminoAcidChain” is possible to 

find the amino acids involved in ligations that we see into the red margin. 

The blue margin, continuing in Figure 15, is where all interaction is configured to be 

show. In Interaction Types box is possible to select what favorable or unfavorable 

interaction that is desired to create, and by create we understanding as a visual 

object listed in data. The box Molecular Scope let to choose the coverage that will be 

applied a search over interactions, and finally, the box Selection Scope that is very 

important to not pollute it with more information that is necessary by select only 

interactions that involves the caffeine molecule. 

 

Figure 15 - DSC showing some interactions after configured to. 

 
Source: self-elaboration 

 

After this point, the student is able to navigate over the information, manipulate this 

tool and would explore this information in a goal to understanding the existing 

interactions between macromolecule and ligand. 
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The expected learned skills that the student should know after the free time of 

interaction are the capacity to recognize the attraction or repulsion parts between 

macromolecule and ligand, and the possible types of these relations. Plus, it is 

important in a future moment as a new interaction cycle with the Learning Object that 

the student make a correlation between your experience and observations on 

manipulating the complex macromolecule/ligand with the literacy about this. 

 



59 
 

6 CONCLUSIONS 

 

After all discussed in theorical reference over a variety of subjects in the field of 

molecular docking and some about learning for the characteristics of new students 

that brings with technology in the education/learning process, and base on the build 

in this work, a list of important conclusions points is here put from now on. 

Recovering the goal of this work to create a script to facilitate the molecules 

visualization and receptor-ligand interaction class planning for teachers in college 

subjects at the pharmacy course, it was thinking about what to use for a better class 

experience. 

In this way, the motivation was conceptualized in context to approximate to the 

technological approach bringing with student reality and given possible more realistic 

interaction with content.  

This basis to think a solution that involves tools that approximate to the student’s 

reality and their entertainment preferences. It concludes an obvious fact that the 

blackboard is not a better way and today students have more familiarity with digital 

against pen and paper.  

Another fact, the nature of molecules is in three dimensions and teachers attempt to 

draw it on blackboard or books to express this in two dimensions, by far it isn’t the full 

experience in interaction with molecules. 

Adding in silico software tools to this equation was the solution. It brought new 

concepts and problems. Concepts surrounding the idea lock and key analogy and 

more actually induced fit concept. Problems arising from the modeling of molecules 

and your interactions like a variety of forms to model and ways to calculate them. 

We encounter a class of software called molecular docking that own an in silico 

superclass. These applications are capable to simulate, with limitations, a receptor-

ligand interaction by a big amount of calcs derived of one algorithm and output in a 

file the result. All of that, receptor, ligand and output are files that has information 

about molecules that describe the same in a three-dimensions, but in text body. 

To show receptor, ligand and output with a result of interaction, it is necessary to 

have programs specifically to visualize in three-dimensions. Theses software read 
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the text files with coordinates information about each atom in molecule and your 

ligations to show it in the screen. The free rotation is possible to see molecules in all 

angle combination of rotation in 360º degrees in each axis for three-dimensions. 

In possession of these resources, this work proposed, in a light way, a manner to 

prepared a class plan with these softwares and how to use this for education/learning 

process, in fashion to improving the molecule visualization and decreasing the gap 

between theoretical description text and two-dimensions pictures to real things. 

Some limitations in this step is that these in silico tools have a computational 

problem, if how much is detailed the model of representation like in a model that 

comprise induced fit concept then more computational cost. Because of that problem, 

we choose a representation model that covers a model more like lock and key 

analogy, and thus, these propose is more compatible with personal computers, 

because this model has less details to be computed in calculations. 

The script to prepare a class was executed and tested with a protein called CYP450-

3A4, an important enzyme to oxidize drugs, but some drugs are your inhibitor and 

this can carry a drug-drug interaction with the patient use two or more drugs, and this 

may cause an intoxication. Besides that, many strong CYP450-3A4 inhibitors was 

used to execute and test the script. 

The results must be compared with literacy by the teacher and student to check with 

molecular docking process results. Even so, with a variety of limitation in each one 

docking result because computational scarce resource, we believe that this proposed 

solution has a good quality to use for education process in reference of 

exemplification better than traditional two-dimensional ligand-receptor interaction. 

For the future works, the application of these knowledges gained here by the 

construction of this proposed scrip to make Learning Objects to aux the process 

education/learning will validate e enable to do improvements. 
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